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Description of the Element: Excel is one of the fundamental elements for education. 

Microsoft Office Excel is a spreadsheet application written and distributed by Microsoft for 

Microsoft Windows and Mac OS X. It features calculation, graphing tools and more.  

 

Known Uses: Organizing data, visualizing trends, making predictions, accounting, 

budgeting, charting/graphing, financial analysis, scientific applications. Spreadsheet help you 

manage data in various formats and can increase your productivity when dealing with various 

types of data. Computerized spreadsheets offer students and teachers a way to view data in 

various formats (pie charts, line graphs, bar graphs, and the like). When students and teachers are 

able to view data in visual formats, they are able to quickly see trends and make predictions.  

 

Isotopes: Students are expected to make and interpret graphs as part of their content 

standards. Why not combine a technology standard and have the student construct and interpret 

charts that are real to them?  

 

 

Symbol:   
 

  

 

 

 

 

 

 

 

Nevada Technology Standards: 
 

 Students demonstrate creative thinking, construct knowledge, and develop innovative 

products and process using technology.  

 Students use digital media and environments to communicate and work collaboratively 

including at a distance, to support individual learning and contribute to the learning of 

others.  

 Students apply digital tools to gather, evaluate, and use information. 

 Students use critical thinking skills to plan and conduct research, manage projects, solve 

problems, and make informed decisions using appropriate digital toss and resources.  
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Spreadsheet Terminology 
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My First Chart 
 

Open the Excel worksheet Water Drip Calculator or copy the 

data table shown on the right into an Excel worksheet.  

 

Highlight the two columns including the headings. 

 

Click the Insert Ribbon tab and Column icon.  

 

 
 

Select the first Column choice then click OK. 

 

 
 

You should have a chart similar to this chart. 

 

 
With a little work, this will be one handsome chart! 

Click on the chart to activate the Chart Tools Ribbon. 
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Select the Layout tab, Chart Title, and Above Chart.  

 
 

The placeholder for the Title is now on the chart. Change the title to read “Amount of Water Lost 

from a Leaky Faucet”. Your chart will be wider, but it should look similar to this.  

 

   
 

 

 

 

 

 

 

 

 

 

Select the Layout tab, Axis Titles, Primary Horizontal Axis Title, and Title Below Axis. 

 

 A new place holder appears for the X-axis 

title.   

 

Enter “Drops per Minute”. 

 

 

 

 

 

 

Select the Layout tab, Axis Titles, Primary Vertical Axis Title, and Rotated Title. 
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Enter “Milliliters Lost per Day” 

 

 

 

 

 

 

 

 

 

 

 

 

Great! Now let’s get rid of the legend. Click on the chart, Select the Legend tab then select None.  

 

   
 

Your chart should look similar to the one shown above.  

 

Let’s add an image background for effect.  

 

Click anywhere in the grid area of the chart. The 

area is selected when you see handles. Now, right 

click to see the Format Plot Area Menu.  
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From the new window, select Picture or texture fill. 

Next, select File and navigate to the image you want 

as a background. 

 

Close this window and you are done.  

 

Congratulations, you are done!  

 

 

 

 

 

 

 

 

 

 

 

That’s a handsome chart!  

 

 

 

 

 

 

 

 

 

More Chart Practice  
 

Open the Excel document Constructing Eight Types of Graphs. Construct the eight types of 

graphs indicated by the tab sheet label.  

 

Your graphs should look similar to those shown below. These charts may be distorted to fit in the 

space provided.  

 

After completing the eight charts, copy the chart to a Word document and upload it the Excel 

Chart Forum.  See page 9.  
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Bubble Chart Area Chart  
 

 

 

Your Assignment 

 
1. Open a Word document.  

2. Put your name in the upper right-hand corner. 

3. Below your name, type today’s date.  

4. Below today’s date type the name of this assignment, Eight Types of Charts using Excel. 

5. Below the title, type the name of each type of chart you created for this assignment and 

paste your chart.  Including water drop calculator, you should have nine charts. 

6. Save this document using the proper format, Your Name – Eight types of charts, and 

upload it to the Excel Chart Forum. 
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Getting Started with Excel 
 

Excel has many built-in functions that can be used to perform calculations on spreadsheet data. 

While most people use only those functions specific to their needs, there are many functions such 

as SUM, COUNT, COUNTIF, AVERAGE, MAX, MIN, ROUND and the IF function that just 

about everyone uses. Below are instructions for inserting these functions into a spreadsheet.  
 

SUM Function ............................................................................................................................... 11 

AVERAGE Function .................................................................................................................... 12 

Minimum Maximum AND MODE Functions  ............................................................................. 13 

COUNT Function ......................................................................................................................... 14 

IF Function  ................................................................................................................................... 14 

COUNTIF Function  ..................................................................................................................... 15 

ROUND Function ......................................................................................................................... 16 

Combining Functions .................................................................................................................... 17 

More Functions  ............................................................................................................................ 17 

Order Of Operations  .................................................................................................................... 23 

Cell Reference And Absoluter Cell Reference  ............................................................................ 27 

Creating A Gradebook .................................................................................................................. 30 

Inserting Rows And Columns ....................................................................................................... 31 

Using Auto Fill ............................................................................................................................. 33 

Averaging Grades In Your Gradebook ......................................................................................... 34 

Headers, Footers, And Print Preview ............................................................................................ 37 

Conditional Formatting ................................................................................................................. 40 

Vlookup Tables ............................................................................................................................. 42 

Vertical Alignment........................................................................................................................ 43 

Formatting Data ............................................................................................................................ 46 

Renaming And Adding Spreadsheets ........................................................................................... 47 
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Common Functions 
 

The SUM Function 

 
1. Open a new spreadsheet. In cell A1 enter “Test Scores”. In cells A2 through A9 enter 

these numbers: 45, 89, 78, 25, 62, 31, 54, 88. 

 
 

2. While in cell A10 click 

on the function button, fx. 

 

Excel has dozens of built in 

functions. All you need to do is 

tell Excel which data to use.  

 

3. Select the SUM. A new 

window opens.  

 

Excel is assuming you want to 

add all the number in the 

unbroken list and defaults to 

A2:A9. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click OK.  
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The results are shown in A10, 472.  

 

Look at the formula shown here. All 

Excel functions must begin with an 

equal sign, =. If you forget to start with 

an equal sign, Excel assumes you are 

entering text.  

 

The function is very simple, SUM 

means add, but you can also do other 

operations using the SUM function. 

The argument is A2:A9. Start with the 

number in cell A2 and add all the 

numbers to cell A9. So the colon, :, 

means through. 

 

 

 

Table of Contents 
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The AVERAGE Function 
 

The AVERAGE function will quickly find the average of a set of numbers.  

 

1. Using the same set of numbers, click in cell A10 and hit the backspace key.  

2. Click on the function button and select AVERAGE.  

3. Click OK 

4. As above, the new window shows the cells to average, A2:A9.  Click OK. 

 

 
  

 

The average, 59, is displayed.  

 

Notice the AVERAGE function is similar to 

the SUM function. Am I seeing a pattern? 
 

 

 

 
 

 

Table of Contents 
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MINIMUM, MAXIMUM and MODE Functions 
 

The statistical functions minimum, maximum, range, mean, and mode are frequently used by 

students. Students usually use paper and pencil, but could use a computer to learn to use 

spreadsheets.  

 

1. Begin by adding two numbers to your list. In cell A10 

enter 45 and cell A11 Enter 82. Whatever is inside a cell 

will be replaced when you enter something new.  

2. In cell A13, enter Minimum Number is.  

3. In cell A14 enter Maximum Number is. 

4. In cell A15 enter Range is 

5. In cell A16 enter Mode is 

6. In cell A17 enter Mean is 

 

For this example I highlighted cells A13 through A17 and used 

right justification.  

 

Notice , also, that column A is wider. Column widths can be 

adjusted in a number of ways, the easiest way is to move the 

cursor between column A and column B. When a double arrow 

appears,  ,click and drag column A to the desired width.  

 

 

7. In Cell B 13 enter the function =MIN(A1:A10). 

8. In Cell B 14 enter the function =MAX(A1:A10). 

9. In Cell B 15 enter the function =A14-A13. (Range 

is the difference between the largest and smallest 

number in a set of numbers. A14 is the maximum 

number, A13 is the minimum number. This formula 

tells Excel to subtract A13 from A14.  

10. In Cell B 16 enter the function =MODE(A1:A10). 

11. In Cell B 14 enter the function 

=AVERAGE(A1:A10). 

 

All of these functions can be found by clicking on the 

Function button, but they are easy enough to type.  

 

As in Word, you can change font style, color and size. 

Borders are added using the circled border button.  
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To view the formulas in a spreadsheet, 

like those shown here, press Ctrl + tilde, 

~ key. Don’t press the shift key.  
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The COUNT Function  
 

The COUNT function is useful when you need to count the number of items that meet a certain 

criteria. This example shows the number of cells that contain data.  
   
 

1. Enter a numbers in cells A1 through A10, 

but skip a few cells. 

2. In cell A11 type “Number of cells with 

data” 

3. In cell B11 enter the formula 

=COUNT(A1:A10). 

 

The results are displayed in cell B11. 
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The IF Function 
 

The IF function checks to see if a certain condition is true or false. If the condition is true, the 

function will do one thing, if the condition is false, the function will do something else. 

  

The IF function we are using in this tutorial asks if the value in column A is greater than the 

value in column B. If it is, the IF function will place the statement "A is larger" in column C. If it 

is not, the IF function will place the statement "B is larger" in column C.  

 

The first statement after the argument, A is larger, will be displayed if the statement is true. The 

second part, B is larger, will be displayed if the statement is false. Both parts must be included in 

the function.  

 

 

 

Our IF function will be entered into cell C1 and it looks like this:  

 

 

The results are shown here.  

 

 

 

 

You could use any of these comparisons: 

Equals (=)  

Less than (<)  

Less than or equal to (<=)  

Greater than (>)  

Greater than or equal to (>=)  

Not equal to (<>) 
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The COUNTIF Function  

 
The COUNTIF function is used to determine how many cells meet a certain condition. For 

example, the formula =COUNTIF(A1:A10,”A”) determines how many cells contain the letter 

“A”.  The COUNTIF function can include relational operators. For example, 

=COUNTIF(D1:D10”80”).  

 

Enter the set of letters and labels shown here. 

 

1. In cell B12 enter =COUNTIF(A1:A10,”A”) 

2. In cell B13 enter =COUNTIF(A1:A10,”T”) 

3. In cell B14 enter =COUNTIF(A1:A10,”G”) 

4. In cell B15 enter =COUNTIF(A1:A10,”C”) 

 

 

5. Enter labels for the results in cells A12 through 

A15.  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

Your results should look similar to those shown here.  
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The ROUND Function 

 

The ROUND function changes the value by rounding it to a specific number of decimal places.  

The format for the ROUND function is =ROUND(argument,number of decimal places).  Where 

the first argument is the cell the value is contained may be found, and the second argument is the 

number of decimal places to which the results are to be rounded.  For example, =ROUND(B9,1) 

rounds the value stored in B9 to 1 decimal place. 

 

Enter the information seen below in the appropriate cells. The average is 78.63636364.  

 

Notice: to round to the nearest tenths, hundredths etc. you must use a negative number, -1, 

-2, etc.  

 

 

 

Another NOTE: Notice $A$12 in the equations above. The dollar sign prevents the cells 

from changing when applying down fill (something we learn later).  
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Your results should look similar to those shown here.   
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Combining Functions 
 

The activities above required two steps, firs find the average, second, round the average to the 

number of decimal places.  It is possible to combine the AVERAGE and ROUND functions into 

one function.  The format is =ROUND(AVERAGE(argument),number of decimal places). 

 

In cell D10, enter the following formula: =ROUND(AVERAGE(B2:B8),2).  This formula will 

find the average and round it to the second decimal place all in one step.  
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More Functions 
 

Clicking on the Function Button or the Insert Menu and dragging to Function allows you to 

select from a variety of functions.  These functions are arranged by category, financial, statistics, 

date and time, and more.  Using function is often easier than trying to enter your own formula. 
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Order of Operations – Rank has its privileges or first things first 
 

As you know, the order in which mathematical operations are performed can give varied results 

depending on which operation gets done first or second.  

 

Formula  Resulting Value 

=(3+5)*(8+7) 120 

=3+5*8+7   50 

=6+2^2   10 

=(6+2)^2   64 

When using formulas in spreadsheets, the computer will perform operations in order of 

parentheses, exponents, multiplication and addition unless the human interface is able to control 

the order. Hopefully, a quick review of the order of operations is all you need to be control the 

computer.  

In the equation 3 + 4 X 5 you would get 23. However, if you added parentheses to the equation, 

(3 + 4) X 5 you would get 35; a pretty big difference.   

 

The lowest order of operations is addition or subtraction, whichever operation is first in order 

from left to right. 

 

For example: 

 

2 + 3 – 4 = ? 

 

First, add 2 + 3, which is 5.  Next, subtract, 5 – 4 = 1.   2 + 3 – 4 = 1 

 

Why did you add first?  It came first going from left to right. 

 

The next higher order of operation is multiplication or division, whichever operation comes first 

in order from left to right. 

 

For example: 

 

12 x 3 ÷ 6 = ? 

 

First, multiple 12 X 3, which is 36.  Next, divide, 36 ÷ 6 = 6.   12 X 3 ÷ 6 = 6 

 

Why did you multiple first?  It came first in order from left to right. 

 

The second highest order of operations is exponents or square roots, whichever comes first in 

order from left to right. 

 

For example:   

 

    

6 squared, 6^2 or 6
2
  - √25  = ? 
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First, square 6, which is 36.  Next, find the square root of 25, which is 5. Then subtract 25 

from 36, which is 9. 

 

Why did you find the square 6 first?  It came first in order from left to right. 

 

NOTE: In Excel, the symbol for multiplying is the asterisk, *, shift 8.  

 

NOTE:  In Excel, exponents such as 6
2
, is written as 6^2, which means six to the power or 

two or six times six. 6^3 means six to the power of three or six times six times six. Press 

shift 6 for the caret. Also known as the hat!  

 

Did you notice there were actually three operations in this problem, the square of 6, the square 

root of 25, and subtraction?  Why did you subtract last?   Subtraction has the lowest rank in the 

order of operations. 

 

The highest rank for the order of operations is the parentheses or brackets, ( ), [ ],  { }. 

 

For example: 

 

[(5 + 7) ÷ 6] X 2 =? 

 

First, add 5 and 7, which is 12.  Next, divide 12 by 6, which is 2.  Then, multiple 2 X 2, 

which is 4.  [(5 + 7) ÷ 6] X 2 = 4 

 

Why did you add first, when addition has the lowest rank?  Because, parentheses has the 

highest rank and 5 + 7 was inside the parentheses. 

 

To remember the order of operations, memorize this simple phrase: 

The initials correspond to the order in which a mathematical expression is 

evaluated. 

 

Please 

Excuse 

My Dear 

Aunt Sally 

 

Parenthesis 

Exponents 

Multiply Divide 

Add Subtract 
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Try these problems on paper.  

  

1. 55 – 5 X 6  =  a.  150 b.  25 c.  300  

 

2.  6 X 2
3
  =  a.  36 b.  48 c.  1728 

 

3. 17 + 16 X 3 + 2 =  a.  67 b.  101 c. 170 

 

4.  100/2 * 10 – 4  =  a.  494 b.  496 c.  300 

 

5.  12 X (3 + 4)  =  a.  84 b.  40 c.  5 

 

6.  20 + 2 * 30/6 + 4  =   a.  17.33 b.  8  c.  34  d.  26 

 

7.  (20 + 2 * 30)/6 + 4  =   a.  17.33 b.  8  c.  34  d.  26 

 

8. 20 + 2 * 30/(6 +4)  =   a.  17.33 b.  8  c.  34  d.  26 

 

9. (20 + 2 * 30)/(6 + 4)  =  a.  17.33 b.  8  c.  34  d.  26 

 

10. 9 + 5(3 + 2 * 7)  =   a.  238 b.  219 c.  94 
 

 
 

 

 

Order of Operations with Excel  
 

Remember:  When using formulas in spreadsheets, it is necessary to use the 

equal sign (=) to start every equation.  For example to add 4 + 9, you would 

enter =4+9 (no spaces between numbers and operation signs).   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Answers: 1. b;  2. b; 3. a; 4. b; 5. a; 6. c; 7. a; 8. d; 9. b; 10. c;  
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Solve each problem shown below in an Excel worksheet. Save the Excel document. (Remember 

to include your name in the file name)  Upload the file to Order of Operation Assignment folder.  

 

1. (23 + 5 × 8)     2. (2 × 63 + 63 × 11 + 2) 
3. (4 ÷ 1) × 1     4. (6 × 3) × 7 
5. (6 – 52) + 33× 2    6. (1 − 6 − 3) 
7. 52 + 9 + (22 × 13 × 5)   8. (72÷ 1 − 8) + 73+ 4 
9. (92 − 3) + 9     10. (33 + 9) × (1 + 9 − 2) 
11. 9 + 9 + (62− 6) × 4    12. 5 − (3 − 3) + 63 ÷ 1 
13. 6 + 1 × (9 − 4) + 6    14. (6 ÷ 6) × (22+ 8) ÷ 1 
15. (22 × 4 × 3)     16. (13 − 6) ÷ 5 
17. (7 – 22 + 3)     18. 43 × (6 + 8) ÷ 1  
19. 4 × (92 ÷ 6 × 5)    20. (5 × 82) + 9 
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Cell Reference and Absolute Cell Reference  
 

1. Enter the labels and data shown below.   

2. In cell D2 enter the formula =B2*C2 then press the Enter key.   

 

The above formula multiplies ( * means multiply) the value of B2 times B3.  B2 and B3 are 

referred to as cell references when placed in an equation, (the place where data may be found in 

a formula or function).  The formula =B2*C2 contains two cell references, B2 and C2. 

 

3. Now click back in cell D2.  Notice the handle in the lower right corner of the cell.   

 

 

 

 

 

 

 

 

 

As you pass the pointer over the handle, it changes to a black cross.  

           

4. When the pointer is a black cross, click the mouse and drag down two cells, D3 and D4. 

5. Release the mouse.  You should see the products for cells B3*C3 and B4*C4.   

 

Click in cell D3.  The formula in the formula bar should read =B3*C3.  How did this happen? 

 

By selecting the fill pointer, the black cross, you instructed Excel to fill the cells below the 

selected cell, D2.  Excel assumes the columns will remain the same and the row number will 

increase.   This process is referred to as down fill.  The filling process will work going up, to the 

right or to the left. 
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Absolute Cell Reference 
 

Open an Excel worksheet and enter the labels and data as shown below.  

To find the shipping charge, multiply the shipping charge, B2, times the weight, cell C5.   

 

 

 

 

 

 

 

 

 

 

 

 

1. In cell D5 enter the formula =B2*C5 then press enter.  

 

 

 

 

 

 

 

 

 

 

 

 

2. As above, use Auto Fill to enter the contents of cells D6 through D8. As you pass the 

pointer over the auto fill handle, it changes to a black cross.            When the pointer is a 

black cross, click the mouse and drag down two cells, D3 and D4. Release the mouse.  

You should see the products for cells B3*C3 and B4*C4. 

 

 

 

 

OOPS! That’s not what I 

wanted.  
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Since Auto Fill assumes the cell changes to the next cell in the column, we get B3*C6, B4*C7, 

and B5*C8. Of course that’s not what we meant. We meant to multiply B2 times C6, and B2 

times C7.  We need to tell Excel not to change B2.   

 

 

 

 

 

 

 

 

 

 

 

To correctly reference our cell, we must use absolute cell reference.  To do this, we put a dollar 

sign, $, in front of the column and row references, $B$2.  This operation allows you to do an 

auto fill without changing the cell reference.   

 

3. In cell D5, enter =$B$2*C5 

4. Repeat the auto fill steps.  

 

 

 

Now, that’s what I’m talking about!  

 

 

 

 

 

 

 

 

 

 

Note: it is to make the row reference 

absolute and not the column or vice 

versa.    

 

 

 

 

 

 

Note: An easier way to insert the $ signs in the formula is to place the cursor anywhere in 

the cell reference and press F4.   
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Creating a simple gradebook 
 

1. Open Excel.  

2. Click in cell A1 and enter YOUR NAME’S Algebra Gradebook – First Quarter.  

Don’t worry if the title goes over the cell size, we’ll take care of that later. 

3. In cell A3 enter Student Name 

4. In cells A4-A7 enter Carter, Jimmy; Lincoln, Abe; Earhart, Amelia; Thatcher, 

Margaret 
5. In cell B3 enter Pg 5.  In cell C3 enter Pg 10. 

6. Highlight cells B3 and C3 by clicking in cell B3 and dragging to cell C3.   

7. Grab the handle and continue dragging to cell E3.  Cell D3 should have automatically 

filled with Pg 15 and cell E3 should contain the label Pg 20 (Auto fill to the right).  

8. Enter Quiz 1 in cell F3 

9. Enter the scores as shown below: 

 

 
 

10. Save your gradebook using the name format “Your Name-Algebra gradebook”. 
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Inserting Columns and Rows 
 

Suppose you had a gradebook program such as your Algebra Gradebook.  Everything was going 

along smoothly for your algebra class of four students until Garth arrived and you realized you 

forgot to include page 18 in the worksheet.  Don’t worry, you don’t have to create a new 

spreadsheet, you can insert columns and rows.  Open your Algebra Gradebook. 

 

   
 

 

First, let’s take care of Garth.  He needs to go between Abraham and Amelia.   

 

1. Click on row number 6, on the number 6; this will highlight the entire row and marks the 

insertion point.  When you insert a new row, it will go on top of row 6. 

 

2. While the row is highlighted, right-click 

to open the menu. Select Insert.  

 

3. In the new row, enter Brooks, Garth. 

 

4. Enter Garth’s scores.  (Of course he 

made up all his work.) 56, 85, 75, 82, 67.  
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Now it is time to insert a column between columns D and E for the missing page 18 assignment.   

 

1. Click on the column label E; this highlights the entire column. Right-click to open the 

drop-down menu. Select Insert.    

 

You have room to enter page 18 and the scores. Of course everyone got a 100 on this assignment 

that’s why you need to enter the scores.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Your gradebook should look like the one above. 
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Using Auto Fill 
 
Once data has been entered into a cell, it is often necessary to repeat this data or to increase the 

data by a fixed increment.  To do this, you need to use the Auto Fill command (Control D to 

down fill or Control R to right fill) or highlight the cell(s) and pull the pointer down or to the 

right to fill adjacent cells.   

 

Using Ctrl-D or Ctrl-R copies the information from the parent cell to all selected cells.  This is 

good if you want to copy the same information.  Otherwise, learn to use the Auto Fill command. 

 

Open the worksheet titled Using Auto Fill. 

 

 
 

Enter 1 in cell A2 and 2 in Cell A3. Highlight the numbers 1 and 2 in column A. Place the 

pointer over the handle located in the lower-right corner, Illustration 2.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What happens if you only highlight cell A2 and do the down fill?   

 

What happens if you only highlight cell A3 and down fill?   

 

Why is it necessary to highlight both cells? 
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Highlight the cell containing the Label “Monday”.  Drag the handle down until the cell contents 

is Sunday.  (The cells will not fill until you release the mouse button, but there is contents 

indicator just to the right of the pointer indicating the changes being made as you drag 

downwards. 

 

 
     

 

Notice the contents of cell A3 is a formula, =A2+1.  All formulas must begin with the equal sign 

(=).  This formula is starting with the contents of cell A2, which is 1, and adding 1 to this value.  

The value stored in cell A3 would be 2, 1 + 1. 

 

      
 

Dragging the handle down would increase the value of cell A4 to the value stored in cell A3, 2 

by adding 1, thus the value of cell A4 would be 3, and so on.  We’ll talk more about filling cells 

later.  Continue dragging the handle to cell A11. 

 

Study the example on the left to see how the 

formulas have changed during the down fill, the 

reference cell increased by one. 
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Time works the same way as the first example above.  Start with a time.  The next time should be 

the starting time, plus the interval with which you intend to increase each value.  For example, I 

started with 9:00 and want to increase each adjacent cell by 30 minutes.  The value stored in cell 

A3 is 9:30. 

 

Highlight cells A2 and A3.  Drag the handle down to cell A10.  This gives me a value of 13:00 in 

cell A10. 
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Averaging Grades in your Algebra Gradebook 
 

1. Open your Algebra gradebook. 

2. Select cell H3. Enter “Average”. In cell H4, enter the formula to calculate the average for 

Jimmy Carter. Hint: =AVERAGE(B4:G4). 

3. Use down fill to calculate the grades for the rest of the class.  

 

 

 

 

 

 

 

 
 

Does your gradebook look like this? 
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Headers, Footers and Print Preview  
 

1. Open your algebra gradebook. 

2. Go to Page Layout and select Custom Margins. 

3. Set the top at 1.5", left and right at .75" and the bottom at 1".  

 

   
 

4. Select Print Titles and then select Header and Footer, Custom Header, and Centered, 

type your school name, class name, your name, and today’s date. 

 

 

 

 

 

 

 

 

 

 

 

Your gradebook will have a custom header. Click in the Custom Footer to add a page number.   
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Your spreadsheet should look 

similar to this example. 

It is a good idea to do a print preview before printing a spreadsheet.  It saves time and paper. 

 

Select Print Preview.  Your document should look like the one below.  While in Print 

Preview adjust the margins to make everything fit on one page. 
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Formatting Data 
 

Let’s get rid of all those decimals in the average scores. 

 

1. Open your 

gradebook.   

2. Click on the letter H 

in the H column. 

3. Select the expand 

selection button in the 

Number Ribbon. 

4. Select the Number 

Tab and the Number 

Category.  

5. Set the number of 

decimal places to 1.  

 

 

 

 

 

 

 

 

 

 

 

 

The average grade now 

has one decimal place.  
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Conditional Formatting  
 

By applying Conditional Formatting, you can look at your gradebook and instantly tell if one of 

your students is in academic trouble.  

 

1. To begin, highlight the data you want 

conditionally formatted. In this example, we will 

use average grades.  

2. From the Home Tab, select the Conditional 

Formatting Ribbon.  

3. Select Highlight Cells Rule. 

4. Select Less Than…  

 

 

 

 

 

 

 

5. None of our students are in danger, let’s set the rule to less than 80. 

 
 

6. Leave the default color as Light Red Fill with Dark Red Text. This should get your 

attention.  

 

We can also conditionally format the letter grades, or words or other numbers, but we will 

conditionally format grades lower than a C.  Excel assigns a value to letters, B is higher than A 

and C is higher than B, and so on. 

 

7. Again, highlight the data you want 

conditionally formatted, averages. 

8. Select Conditional Formatting from 

the Home Ribbon.  

9. Select Greater Than… 

10. Enter Greater Than 88.9.  

11. Select Green Fill 

12. Press OK.  
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How’s that? Now you know who to watch and who to praise.  
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VLOOKUP Tables 
 

A vertical lookup table is able to return an assigned value based on a set of criteria. In this case, 

the lookup table will return a letter grade based on the student’s average. 

 

VLOOKUP tables, like the table in A12:B24 are in ascending order.   

 

1. Create the lookup table; Starting in Cell A12 enter the numbers 

shown on the right.  

2. Highlight the entire table; Cells A12 through B24.  

3. Go to the Name box and name the table, lookup.   

 

It is important that you have highlighted all the cells in what 

will be the lookup table.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. In cell I3 enter the label “Grade”. 

5. In cell I4 enter the formula:  =VLOOKUP(H4,lookup,2). 

6. If a letter grade of B is returned, down fill the remainder of the column.  
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VLOOKUP tells the computer it will be using a vertical lookup table.  H4 is cell where the value 

can be found, in this example, 87.8%.  "lookup" is the name of the table to look for the value to 

be returned. 2 is the column from where the value will be returned, B in this example. 
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Other Helpful Excel Tricks 

 

Vertical Alignment 
 

Sometimes it is necessary to align labels vertically or column width becomes too wide to 

manage.  Labels may be aligned vertically to conserve space and to make the worksheet more 

attractive.   

 

1. Enter the following information in a worksheet.  

 

Student 

Tale of 
Two 

Cities 

Light in 
the 

Forest 
The 

Outsiders 

Red 
Badge of 
Courage Twilight 

Mohammad 
     Christine 
     Khateja 
     Bob 
      

2. Place the cursor in the 

cell that contains the label, Tale 

of Two Cities. From the Home 

Ribbon select the align icon. The 

window shown below will open.  
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3. Click and drag the Red dot on the 

Orientation indicator to the top, 90 degrees.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To adjust the column 

width, move the cursor 

between columns B and 

C.  You should get the 

double arrow pointer 

cursor.   

 

 

 

 

 

 

 

An easier way to adjust 

column widths for the contents 

of the widest cell is to double 

click the cursor between the 

two columns. Excel will 

automatically adjust the 

column for the widest item.   
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With cell B2 still selected, click the Format Painter.  Click in cell C3 and 

drag to cell F3.  All book titles should now have the same vertical alignment 

as cell B3.  Adjust the column widths to be just wide enough for the book 

titles. 

 

 

 

 

 

 

Completely formatted  

 

 

 

 

 

 

 

 

 

 

 

 

Table of Contents 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Educational Applications for Spreadsheets in the Classroom 
Don Carlin – Touro University – dhcarlin@interact.ccsd.net  

 

46 

 

Formatting Data – Merging Cells, Center, Underline, and Bold 
 

Open the workbook Center, Underline and Bold.  Copy the contents of this the worksheet 

to Sheet2 of your Gradebook workbook.  

 

Highlight cells A4 through G4.  Click on the Center Button on the Formatting Toolbar.  While 

these cells are highlighted, click on the Bold Button on the same toolbar.  Then click on the 

Underline Button. 

 

1. Merge cells A1 to G1.  

2. Bold the title. Draw a Thick Box Border around the title.  

3. Bold, underline, and center all column headings. 

4. Draw boarders around all entries.  

5. Right-align the Total. Italicize the Total. Color the Total red.  

6. Center align the totals for each column.  

 

Your table should look similar to the example below.  

 

ISG District Attendance for School Year 2007-2008 

      

 

Number of Students Yanbu Dhahran Jubail Rahema Asir 

August 16 22 23 24 13 

September 20 18 9 5 21 

October 19 6 12 9 9 

November 14 23 21 7 11 

December 18 8 12 14 18 

January 23 7 13 22 18 

February 14 10 17 25 16 

March 18 16 16 22 10 

April 14 11 6 5 13 

May 23 11 20 24 12 

Total 180 131 149 156 140 
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 Renaming Worksheets 
 

Open the document “Renaming Worksheets”.   

 

Notice that Sheet1 is named Sheet1, not Sheet 1 (space between Sheet and 1).  If a space is left in 

the name, it cannot be used to hyperlink data.  It is always a good idea to name a worksheet 

without spaces in the name. 

 

Double click on the spreadsheet name, Sheet1. While the name is highlighted, change the name -

by typing the new name over the old name. Or you can right-click on Sheet1 and select Rename.  

 

 
 

Rename Sheet1 to MinusGarth 

Rename Sheet2 to WithGarth 

Rename Sheet3 to WithPage18 

Rename Sheet4 to Gradebook 

 

Using the same process, you can change the worksheet tab colors. 

 

   

 

 

Change the color of MinusGarth to Red; WithGarth to Blue; WithPage18 to Green; and 

Gradebook to Yellow. 
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Adding Worksheets 
 

 
 

Click the new worksheet icon to add a worksheet to your workbook.  Rename the new worksheet 

and change the color. Move the new worksheet to the front of the list (click and drag). 

 

Right-click on the new worksheet. Select Delete to delete it.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Prior to turning in your gradebook, add a fourth worksheet. Name your worksheets, Quarter1, 

Quarter2, Quarter3, and Quarter4.  Make each worksheet a different color 

 

 

 

 

 

Copy the names from Quarter1 and paste them in the other three quarters.  

 

What your gradebook should contain: 

 

1. Five students, six assignments, an average grade rounded to one decimal place, a letter 

grade calculated from a lookup table, conditional formatting for students under 80% and 

students over 88.9% . 

2. Four worksheets named Quarter1, Quarter2, Quarter3, Quarter4. Each given a different 

color. 

3. A fifth worksheet named VerticalAlignment, color it too. 

4. Upload your Gradebook to the Gradebook Assignment folder.  
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